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чего страховая организация, финансовая устой-
чивость которой высоко оценена по данным 
российской отчетности, далеко не всегда может 
рассчитывать на такую же оценку по МСФО-
отчетности;3) разные требования к структуре и 
формату отчетности: МСФО предъявляют лишь 
общие требования к перечню статей финансовой 
отчетности, в связи с чемони отличаются в раз-
ных страховых организациях [3].Вместе с тем 
необходимо подчеркнуть, что развернутая оцен-
ка деятельности страховщика с использованием 
совокупности показателей МСФО-отчетности 
дает возможность заинтересованным пользова-

телям принимать обоснованные управленческие 
решения на внешнем уровне контроля со сторо-
ны надзирающих органов, а также на внутрен-
нем уровне управления с целью повышения ка-
чества менеджмента.
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Ежегодно растет объем финансирования 
для образования. Одним из аспектов развития 
образования является внедрение в учебный 
процесс электронных обучающих средств. 
Электронные средства обучения способству-
ют эффективному усвоению материала сту-
дентами в учебном процессе. Поэтому вопро-
сы разработки электронных учебных изданий 
и мультимедийных обучающих программ яв-
ляются актуальными [9].

Объектом электронных учебных изданий 
должна быть цифровая, текстовая, графиче-
ская, аудио, видео и другая обучающая инфор-
мация, представляющая собой совокупность 
научно обоснованных фактов, утверждений и 
правил, а также свойств и отношений объектов, 
явлений и процессов, изучаемых в рамках дан-
ного учебного курса [3].

Внедрение мультимедийных технологий  в 
сферу образования сделало возможным исполь-
зование компьютерных программ как иллюстра-
тивных материалов, проведение тестирования и 
контрольных работ при помощи компьютерной 
техники, сочетая традиционные домашние за-
дания с творческими. Стала возможной  орга-
низация дистанционных уроков [6]. Многие за-
дания по предмету в компьютерном варианте 
(или выполняемые при помощи компьютерной 
техники) позволяют развить творческие способ-
ности учащихся, взглянуть на предмет с разных 
сторон и проявить себя в новой деятельности или 
ситуации. [2]. Широкое внедрение информаци-

онных технологий в образование дает возмож-
ность выбора оптимального набора технологий 
для организации учебного процесса. При выборе 
необходимо учитывать их соответствие инди-
видуальным качествам обучаемых и специфи-
ческим особенностям конкретных предметных 
областей. При работе с мультимедийными техно-
логиями учащиеся с самого начала вовлечены в 
активную познавательную деятельность. В ходе 
такого обучения они учатся не только приобре-
тать и применять знания, но и находить необходи-
мые для них средства обучения и источники ин-
формации, уметь работать с этой информацией. 
Используя системы мультимедиа, позволяющие 
объединить возможности компьютера и знания 
учителя, стало возможным создание электронных 
учебников и программ, которые более наглядно, 
красочно и с мобильным доступом к информации 
предстанут перед обучающимися. В педагогике 
наглядность всегда считалась и считается одним 
из важнейших принципов обучения, фундамен-
том для осуществления всестороннего развития 
личности [4].

К особенностям мультимедийной обучающей 
программы по сравнению с печатным следует от-
нести: возможность включения специальных фраг-
ментов, моделирующих течение многих физиче-
ских и технологических процессов; возможность 
включения в обучающую программу аудио-файлов, 
в частности, для сближения процесса работы с про-
граммой и прослушивания лекций этого же препо-
давателя; возможность включения в состав обуча-
ющей программы фрагментов видеофильмов для 
иллюстрации определенных положений программы; 
включение в состав мультимедийной обучающей 
программы интерактивных фрагментов для обеспе-
чения оперативного диалога с обучаемым; полномас-
штабное мультимедийное оформление программы, 
включающее в себя диалог на естественном языке, 
организацию по запросу обучаемого видеоконферен-
ции с автором (авторами) и консультантами и пр. [5].

В данной статье мы акцентируем внимание 
на применение Macromedia Flash 8 для создания 
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анимаций к разработанной мультимедийной об-
учающей программе по дисциплине «Анализ 
алгоритмов».   

Анимация – это последовательное изменение 
состояния объекта. С точки зрения Macromedia 
Flash имеется несколько видов анимации: про-
стая покадровая анимация, Tweening (анимация 
с построением промежуточных кадров), анима-
ция формы и анимация с использованием эффек-
тов шкалы времени (Timeline Effects).

Технология Macromedia Flash представля-
ет собой симбиоз изобразительного искусства, 
видео и языка программирования. Графический 
редактор предоставляет разработчику широкую 
палитру инструментов для создания стильных 
красочных изображений. Структура документов 
Flash основана на последовательности кадров, 
по которым проходит головка воспроизведения 
фильма, создавая тем самым эффект анимации. 
Каждый Flash-документ содержит линейную 
последовательность кадров, фрагментов видео- 
или звукового сопровождения. Перемещение от 
кадра к кадру осуществляется за счет перехода 
воспроизводящей головки. При этом перехо-
де изображение на экране обновляется, а затем 
выполняется код текущего кадра, который при-
креплен к нему при помощи встроенного языка 
программирования Action Script. [4].

Структура разработанной мультимедийной 
обучающей программы включает в себя следую-
щие разделы: учебную программу дисциплины, 
теоретический материал, задания, примеры, во-
просы, тесты, глоссарий, тезаурус. 

Мультимедийная обучающая про грамма со-
держит богатый теоретический материал, кото-
рый хорошо структурирован и имеет удобный 
интерфейс, на рисунке 1 показано окно форми-
рования содержимого уроков.

Структура мультимедийной обучающей 
программы состоит из модулей, модули состоят 
из блоков, а блоки состоят из уроков.

Одним из удобных средств создания муль-
тимедийных обучающих программ является 
Macromedia Flash – средство создания анимиро-
ванных проектов на основе векторной графики с 
встроенной поддержкой интерактивности.

Покадровая анимация является самой про-
стой формой анимационных изображений в 
программе Macromedia Flash Professional 8. По-
кадровая анимация характеризуется использова-
нием уникальных изображений в каждом кадре, 
и потому очень подходит для создания сложных 
анимаций, в которых каждое движение будет ин-
дивидуальным и неповторимым. Конечно, для 
создания неповторимых изображений в каждом 
кадре может потребоваться масса терпения и вы-
держки, а также большое количество времени, 
но результат может превзойти все ожидания.

Структура мультимедийной обучающей 
программы состоит из модулей, модули состоят 
из блоков, а блоки состоят из уроков.

Одним из удобных средств создания муль-
тимедийных обучающих программ является 
Macromedia Flash – средство создания анимиро-
ванных проектов на основе векторной графики с 
встроенной поддержкой интерактивности. 

Рис. 1. Содержание мультимедийной обучающей программы

Покадровая анимация является самой про-
стой формой анимационных изображений в 
программе Macromedia Flash Professional 8. По-
кадровая анимация характеризуется использова-
нием уникальных изображений в каждом кадре, 
и потому очень подходит для создания сложных 
анимаций, в которых каждое движение будет ин-

дивидуальным и неповторимым. Конечно, для 
создания неповторимых изображений в каждом 
кадре может потребоваться масса терпения и вы-
держки, а также большое количество времени, 
но результат может превзойти все ожидания. 

Применение покадровой анимации так-
же увеличивает размер итогового видео файла, 
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так как вес имеет каждый кадр. В программе 
Macromedia Flash Professional 8 каждый кадр, со-
держащий уникальное изображение, называет-
ся ключевым кадром. Для создания покадровой 
анимации нужно нарисовать уникальное изобра-
жение в каждом кадре, и таким образом каждый 
кадр становится после этого ключевым. 

При покадровой анимации содержимое ра-
бочей области изменяется в каждом кадре. По-
кадровая анимация наиболее хорошо подходит 
для сложной анимации, при которой изображе-
ние меняется в каждом кадре, а не перемещается 
по рабочей области. При покадровой анимации 
размер файла увеличивается сильнее, чем при 
tween-анимации. В покадровой анимации Flash 
Professional хранит значения для каждого завер-
шенного кадра.

Для создания покадровой анимации определи-
те все кадры как ключевые и создайте различные 
изображения для каждого кадра. Изначально каж-
дый новый ключевой кадр имеет то же содержимое, 
что и предшествующий ему ключевой кадр, поэто-
му можно последовательно модифицировать кадры 
анимации.

При создании анимации любого вида 
приходится работать со шкалой времени, на 
которой располагаются все кадры фильма. 
Настраивать временную шкалу можно с по-
мощью кнопки. При нажатии на эту кнопку 
раскрывается меню Frame View (Вид кадра), 
в ниспадающем меню будут представлены: 
Tiny (Очень маленький); Small (Малень-
кий); Normal (Обычный); Medium (Средний); 
Large (Большой); Short (Короткий) – уменьше-
ние высоты кадров.

Кадры бывают двух типов: ключевые и 
статические. Ключевые кадры играют особую 
роль – в них и могут содержаться изображе-
ния (статические кадры проигрываются как 
бы «впустую»). На шкале времени ключевые 
кадры изображаются маленькими кружочка-
ми. Если кружочек не закрашен – в ключевом 
кадре ничего нет, он пуст. 

При использовании анимации движения 
типа Tweening достаточно задать состояния на-

чального и конечного ключевых кадров, проме-
жуточные кадры будут достроены программой.

Во время создания покадровой анимации не-
обходимо  работать с кадрами: добавлять клю-
чевые кадры, удалять лишние ключевые кадры, 
вставлять и удалять обычные кадры. Все это 
делается либо через меню Edit – Timeline, либо 
через клик правой клавишей мыши. Кликнув пра-
вой клавишей мыши на кадре, вы можете: Insert 
Frame – вставить кадр; Insert Keyframe – вставить 
ключевой кадр; Remote Frames – удалить кадры 
(один или несколько). Если Вы выделите сразу 
несколько кадров с помощью перемещения по 
ним мышкой с нажатой левой клавишей, Вы их 
сразу все можете удалить.

Insert Blank Keyframe – вставить пустой 
ключевой кадр, изображение в котором не будет 
повторять изображение предыдущего кадра;

Clear Keyframe – удалить изображение клю-
чевого кадра, при этом он перестанет быть клю-
чевым.

Clear Frames – удаляет изображение кадров 
(одного или нескольких). Если удалить изобра-
жение ключевого кадра, он станет пустым клю-
чевым кадром. [8].

Рассмотрим некоторые шаги применения 
Macromedia Flash 8 для создания анимаций к 
разработанной мультимедийной обучающей 
программе. Открыв программу Macromedia 
Flash 8, создаем новый документ с помощью 
File => New document. Для импортирования уже 
имеющегося изображения выполняем действия 
File => Import => Import to Stage.

Import to Stage – импортирует в програм-
му изображения, сохраненные на данном ком-
пьютере. В открывшемся окне необходимо 
выбрать изображение, созданное в формате 
Html,  нажать «Открыть»  на рисунке 2  по-
казано импортируемое изображение.Далее 
создаем первый символ анимации с помощью 
директории  Insert=> New Symbol. В открыв-
шемся окне выбираем Movie Clip для созда-
ния движущейся анимации. И создаем текст. 
Для этого на панели инструментов выбираем 
Text Tool.

Рис. 2. Импортируемое изображение
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Далее, необходимо выбрать конечное ме-

сто, где будет находиться текст. Для этого, 
на шкале времени выбираем нужный кадр 
и с помощью нажатия правой кнопки мыши 
выбираем элемент Insert Keyframe. Затем 
перетаскиваем текст в необходимое место 
и выделяя первый кадр  выбираем элемент 
Actions=>Properties=>Tween : Motion. После 
выполнения указанных функций на шкале вре-
мени появляется стрелка.

Далее  созданный текст накладываем на 
изображение. Для этого выбираем директорию 
Window=>Library.

Созданный ранее символ текст ставим в 
кадр перетащив с помощью мыши.

Далее переходим в опцию Actions и пропи-
сываем код. Выберите процедуру, которая должна 
выполниться, когда загружен кадр. Flash введет 
следующий код Action Script в список Actions (Про-
цедуры): On (release) {go to And Stop (3)}. 

Где инструкция On (Release) указывает, что 
когда кнопка будет отпущена, Flash запустит 
воспроизведение фильма. Операция go to And 
Stop («Имя Кадра» или Номер). Фильм перехо-
дит к указанному кадру, воспроизведение при-
останавливается до получения команды Play. 

Рис. 3. Новый кадр

Затем вставляем новый второй кадр и с по-
мощью нажатия правой кнопки мыши выбираем 
опцию Insert KeyFrame.

Далее, как и в первом кадре создаем небхо-
димые анимации, кнопки и тексты и получаем 
новый кадр, показанный на рисунке 3.Разрабо-
танная мультимедийная обучающая программа 
предназначена для использования ее на заня-
тиях, а также для самостоятельной работы сту-
дентов. [7]. При помощи нее каждый студент 
может заниматься индивидуально. [1]. 
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